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1 Disclaimer 
A. For customers domiciled outside Germany /  

Für Kunden mit Sitz außerhalb Deutschlands 

„Warranty, Liability: 

The user shall be solely responsible for the use of this products described within this file. ABB 

shall be under no warranty whatsoever. ABB's liability in connection with application of the 

products or examples provided or the files included within these products, irrespective of the 

legal ground, shall be excluded. The exclusion of liability shall not apply in the case of intention 

or gross negligence. The present declaration shall be governed by and construed in accordance 

with the laws of Switzerland under exclusion of its conflict of laws rules and of the Vienna Con-

vention on the International Sale of Goods (CISG)." 

„Gewährleistung und Haftung: 

Der Nutzer ist allein für die Verwendung des in diesem Dokument beschriebenen Produkte und 

beschriebenen Anwendungsbeispiele verantwortlich. 

ABB unterliegt keiner Gewährleistung. Die Haftung von ABB im Zusammenhang mit diesem An-

wendungsbeispiel oder den in dieser Datei enthaltenen Dateien - gleich aus welchem Rechts-

grund - ist ausgeschlossen.  Dieser Ausschluss gilt nicht im Falle von Vorsatz oder grober Fahr-

lässigkeit. Diese Erklärung unterliegt Schweizer Recht unter Ausschluss der 

Verweisungsnormen und des UN-Kaufrechts (CISG)." 

 

B. Nur für Kunden mit Sitz in Deutschland 

„Gewährleistung und Haftung: 

Die in diesem Dokument beschriebenen Anwendungsbeispiele oder enthaltenen Dateien be-

schreiben eine mögliche Anwendung der AC500 bzw. zeigen eine mögliche Einsatzart. Sie stel-

len nur Beispiele für Programmierungen dar, sind aber keine fertigen Lösungen. Eine Gewähr 

kann nicht übernommen werden. 

Der Nutzer ist für die ordnungsgemäße, insbesondere vollständige und fehlerfreie Program-

mierung der Steuerungen selbst verantwortlich. Im Falle der teilweisen oder ganzen Über-

nahme der Programmierbeispiele können gegen ABB keine Ansprüche geltend gemacht wer-

den. 

Die Haftung von ABB, gleich aus welchem Rechtsgrund, im Zusammenhang mit den Anwen-

dungsbeispielen oder den in dieser Datei enthaltenen Beschreibung wird ausgeschlossen. Der 

Haftungsausschluss gilt jedoch nicht in Fällen des Vorsatzes, der groben Fahrlässigkeit, bei An-

sprüchen nach dem Produkthaftungsgesetz, im Falle der Verletzung des Lebens, des Körpers 

oder der Gesundheit oder bei schuldhafter Verletzung einer wesentlichen Vertragspflicht. Im 

Falle der Verletzung einer wesentlichen Vertragspflicht ist die Haftung jedoch auf den vertrags-

typischen, vorhersehbaren Schaden begrenzt, soweit nicht zugleich ein anderer der in Satz 2 

dieses Unterabsatzes erwähnten Fälle gegeben ist. Eine Änderung der Beweislast zum Nachteil 

des Nutzers ist hiermit nicht verbunden. 

Es gilt materielles deutsches Recht unter Ausschluss des UN-Kaufrechts." 
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2 Introduction 

2.1 Scope of the document 

This document refers to an example program named ‘V3_OPC_Example_V2.5.project’ on how to 

configure the OPC server for V3 CPU, including OPC DA and UA. 

2.2 Compatibility 

The application example explained in this document have been used with the below engineer-

ing system versions. They should also work with other versions, however some small adapta-

tions may be necessary, for future versions. 

• AC500 V3 PLC 

• Automation Builder 2.2.0 or newer 

2.3 Overview 

OPC Unified Architecture (UA) is an open standard created by the OPC Foundation with help 

from dozens of member organizations. Although UA intends to provide a platform independ-

ent interoperability standard (in-order to move away from Microsoft COM), it is not a replace-

ment for OPC Data Access (DA) technologies. For most industrial applications, UA will comple-

ment or enhance an existing DA architecture. It will not be a system-wide replacement. OPC UA 

complements OPC DA infrastructures in the following ways: 

• It offers a secure method of client-to-server connectivity without depending on Mi-

crosoft DCOM and has the ability to connect securely through firewalls and over VPN 

connections. For users connecting to remote computers within the corporate network 

(inside the firewall) on a domain, an OPC DA and DCOM connection may be satisfac-

tory.  

• It provides an additional way to share factory floor data to business systems (shop-

floor to top-floor). OPC UA can aggregate data from multiple OPC DA sources into non-

industrial systems.  

For the majority of user applications, the most relevant components of the UA standard are as 

follows: 

• Secure connections through trusted certificates for client and server endpoints.  

• Robust item subscription model to provide efficient data updates between clients and 

servers 

• An enhanced method of discovering available information from participating UA serv-

ers. 

 

 
NOTICE 

For more information on OPC UA, please search the key words ‘OPC UA’ in 

search engine website. 
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3 How to get and install the OPC Server 
This section describes how to install the OPC Server OPC V3 and Gateway V3. 

Before you execute the installation, you must close all OPC Client, the ABB OPC Tunnel and 

the Gateway (CODESYS gateway server) on your PC. Please check these with the Windows 

Task Manage.  

 

Figure 1: Windows Task Manager 

The Processed of  

• Gateway.exe 

• CoDeSysOPC.exe 

• WinCoDeSysOPC.exe 

• OCTsvc.exe 

• Must have disappeared. 

 

If not: 

• End the processes with the Windows Task-Manager.  

• Stop the ABB OPC Tunnel Windows Component Service, Services (local).  
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3.1 OPC Server V3 and CODESYS Gateway V3/V2 

Install the OPC Server V3 directly from the Additional Tools in Automation Builder. You can 

download the installation package from website www.abb.com/automationbuilder or 

https://new.abb.com/plc/automationbuilder/platform/software 

 

OPC Server V3 is delivered in the Ssetup from Automation Builder installer. After down-

loading the package, Launch the ABB Automation Builder installation wizard. 

Select Install Addition Tools. 

  

Agree to the License terms and click ‘Next’ button. 
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Choose CoDeSys OPC Server 3.5, with this the OPC Server V3 is installed and registered. 

  

CoDeSys OPC Server 3.5 and CoDeSys OPC Server 2.3 can be installed in parallel. 
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Click ‘Download and install’ 

  

Choose the CoDeSys Gateway 3.5. And deselect the features you do not want to install.  
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The OPC Server is able to communicate with both, AC500 V3 and AC500 V2 PLCs, at the 

same time. 

 

Click “Finish” to complete the installation. 
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NOTICE 

For using the OPC Server V3 on a Windows Vista system, it’s strongly rec-

ommended to run the OPC client in Windows XP SP2 compatibility mode 

and with extended administrator rights in order to get a continuous up-

dating of the values. 

 

You can install the gateway about the installation of the server OPC V2/V3 

(see above). Servers OPC V2 and V3 can be installed in parallel. 

 

It is not necessary to install CODESYS OPC Server V3/V2 if you want to com-

municate PLC with only OPC UA. 

  

3.2 Manual Registration and Unregistration 

During the installation with Automation Builder 2.2.0, all needed files are installed for OPC 

and the OPC Server is registered automatically as user application. 

Further on, there is the possibility to register resp. to uninstall the OPC Server manually 

either as COM Server (user application) or as service. 

 

3.2.1 Parallel installation and registration 

With command  

WinCODESYSOPC /RegServer  

the server is registered as COM server. Thereby as location path always the current position 

of WinCODESYSOPC.exe will be used. Thus, the call only may be done from a local path.  

 

3.2.2 Registration as service  

With command  

WinCODESYSOPC /Service  

WinCODESYSOPC.exe gets installed as system service. Started once, the service will stay 

“started” until the system gets terminated. The communication to the configured PLCs 

survives.  

The service is also installed here at the current position of WinCODESYSOPC.exe. 
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3.2.3 Uninstalling 

With command  

WinCODESYSOPC /UnRegServer  

All entries of the OPC Server will be removed from the registry. The installed files will not 

be removed. 

 

 

TIP 

Register the OPC server in the registry as interactive software with 

command: 

• For OPC 3: WinCoDeSysOPC/RegServer 

• For OPC 2: CoDeSysOPC/RegServer 

Register the OPC server as system service with command: 

• For OPC 3: WinCoDeSysOPC/Service 

Unregister the OPC server from registry and from service entry with 

command: 

• For OPC 3: WinCoDeSysOPC/UnRegServer 

• For OPC 2: CoDeSysOPC/UnRegServer 

 

 
NOTICE 

Don’t forget to reboot your PC after Registration or Uninstalling. 

 

3.3 Hardware and Software Version requirement 

 

 
NOTICE 

The following configuration and version are used in this example. Newer 

versions of hardware and software should work, however if not mentioned 

here, it should be tested by the user himself. 

 

 

Hardware Software 
AC500 CPU: PM5650-2ETH, FW: 

V3.2.0 
Automation Builder 2.2.0 Build 355 

PC Windows 10 (32/64 Bit) Professional / Enterprise 

CP6607 Panel Builder 600 4.0.1 build 462 

 

  



 AC500 HOW TO USE OPC SERVER V3  

 3ADR010407, 2, en_US 13 

3.4 Overview and connections 

The overview of the system is explained in the image below where it is connected to a 

SCADA system (Clients) and devices PLCs ( or DCS, remote IOs..). 

 

  

Figure 2: Simple hardware connection example 

 

We’ve seen some of the effort involved in making an HMI tag and historian database 

 

The one in the red circle involves current OPC DA 

The one in the blue circle involves OPC UA 
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4 Configuration of the symbols in the 

programming system 
This chapter shows you how to configure the symbols for OPC communication in V3 CPU 

(for example, AC500 PM5650).  

Processor Mod-

ule 

Program 

Memory 

Network Interface Other Interfaces Suitable Termi-

nal Base 

PM5630-2ETH 8 MB 2 x onboard Ethernet CAN and COM1 TB56xx-2ETH 

PM5650-2ETH 80 MB 2 x onboard Ethernet CAN and COM1 TB56xx-2ETH 

PM5670-2ETH 160 MB 2 x onboard Ethernet CAN and COM1 TB56xx-2ETH 

PM5675-2ETH 160 MB, 8 GB 

flashdisc 

2 x onboard Ethernet CAN and COM1 TB56xx-2ETH 

 

To add Symbol Configuration, select the Application object in the Automation Builder 

2.2.0 device tree and add object Symbol configuration (Project-> Add Object->Symbol 

configuration). The symbol configuration editor appears. 
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Check the option ‘ Support OPC UA Features’, then click Add button. 

 

 

 
NOTICE 

Symbol includes the Items (variables) which exchanges with PLC, this is 

needed for OPC communication. 

You can ignore this step if you only want to configure OPC DA communication, 

instead of pressing ‘Add’ button with default settings directly. 

 

In Symbol Configuration editor, execute ‘Build’ command to enable the variables selection 

(you need an error-free build). 

 

Then you will see all Items (variables) in the window and select the desired Items which ex-

changes with PLC, these are need for OPC communication. 
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Go to Online-> Login, with commanding Login the application will be compiled and down-

loaded. 

 

 
NOTICE 

Do not configure the program as a cyclic program, please use a task 

configuration. Go to the Task Configuration and have a look to the Monitor 

information. For example the program has a cycle time of 40ms, use a task 

time of 50 or 60ms. So the CPU has time to answer the OPC request from the 

OPC Server between the tasks. 
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5 Configuration of the OPC server v3 
For the connection between OPC DA(AE) client and PLCs there are parameters defined in the 

file ‘OPCServer.ini’. 

The configuration of the OPC Server can be done with the tool OPCconfig.exe and then will be 

stored in the OPCServer.ini file. 

5.1 Open a particular INI file 

Start via 3S CODESYS/CoDeSysOPC Server V3/OPC Configurator, or start the OPC configurator 

by fold-er C:\Program Files (x86)\3S CODESYS\CODESYS OPC Server 3\ OPCConfig.exe directly. 

 

 

 

When "OPCConfig.exe" is called, the current configuration of the "OPCServer.ini" is 

displayed. 

If the configuration is required for other project purposes, also save it under a new name. 
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5.2 Settings for OPC server 

This dialog is available when the root entry Server is selected in the configuration tree. 

Basic update Rate of the OPC-Server in milliseconds. This is the cycle time according to 

which all item data are read from the PLC. The data get written into the cash with which 

the client communicates with a separately defined update rate. 

Normally the default setting would be preferred. However, it depends on the application 

how many Items are expected to communicate. 
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Logging  

• Enable Logging (Defaultevents): Default: active  

If this option is activated, any actions as well as errors on the OPC server will be recorded 

in a LOG file. This file will be stored in the installation directory and will be named 

OPCServer.log. After a shutdown of the OPC Server the LOG file can be evaluated. The 

messages of several OPC sessions are lined up in one LOG file until it reaches the size of 1 

MB. Then the current date will be added in the file name (OPCServer<date>.log, e.g. 

OPCServer17.03.2017.log) and the file will be saved. After that a new LOG file 

OPCServer.log will be created.  

• Log Additional Events: Default: not active  

If this option is active, then additional events are written into the LOG file.  

• Add Debug Events (slow): Default: not active  

If this option is active, then debug events are written into the LOG file.  

 

 
NOTICE 

Update Rate may not be 0ms, The default value of 200ms is suitable value of 

many applications. The adjustment for the Update Rate depends on the 

number of symbols (variables).For a big number of symbols it would be better 

to increase the update rate. 

5.3 Settings for <PLC> 

This dialog is available, if the PLC entry is selected in the configuration tree. 

 

Choose ‘GATEWAY3’ as the Interface. 

Concerning the Project name, this is only used if interface SIMULATION3 is contemporary 

used too. The name of the symbol file has to be set here accordingly. 

The checkbox ’Active’ must be checked. 

The checkboxes ’Enable logging’, ‘Log Additional Events’ allows a later diagnosis.  
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5.4 Settings for connection to <PLC> 

This dialog will be available if entry Connection below a <PLC> is selected in the configu-

ration tree. 

 

To create a new communication or to change an existing one, open the CoDeSys address 

dialog of the PLC via the Edit button. 

 

Enter the IP address and port for the gateway and for identifying the PLC specify either 

the name or address. 
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Each the settings must correspond to those defined in Communication Settings tab of the PLC. 

 

 

 

Alternatively, you can enter the address and port of the TCP/IP blockdriver. 

 

 

 

After closing the dialog with OK, the settings will be displayed in the main dialog. 
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If more than one PLC, repeat the same steps for the other PLCs. 

Save as by default “OPCServer.ini” in the installation directory. 

 

 

 

Exit 
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6 Check OPC function with AC500 
If the PLC(Device)configured in the CODESYS project is not available, the OPC server allow 

to work in simulation mode. 

 
NOTICE 

It is strongly recommended to check the function of the previous configura-

tion steps. 

 

6.1 Check OPC Server V3 without AC500 

In the OPC server INI file, a simulation access is configured by selecting the Interface 

‘SIMULATION3’ and by setting the name of the symbol file in Project name. The symbol file 

is automatically generated by a build command of a V3 project when a symbol configura-

tion exists and is stored with the name extension XML next to the project file. If this file is 

stored in the OPC server directory, then only the project name has to be specified here. 

But it can also be copied to any location, then under Project name also the directory name 

has to be specified.  

Dialog with configuration of a simulated access to the stock of symbols of Simulated PLC 

 

 

The directory and the name of the symbol file has to be set. The directory need not to be 

set, if the file is stored in the same directory as OPCServer.ini. 

Start MatrikonOPC Explorer, Connect CoDesys.OPC.DA, Add Group, Add Items, Select 

Available Items in ‘Server CoDeSys.OPC.DA’,Add to Tag List, Close the Item browser… 
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If anything is right, then CoDeSys.OPC.DA is connected. The OPC Client is running and the 

quality of the items is good. 

 
NOTICE 

Connection settings is not necessary for the simulation. 

MatrikonOPC Explorer is a free OPC Client packed with functionality for test-

ing and troubleshooting OPC servers and OPC connections. 

 

Check Processes with Windows Task Manager 
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NOTICE 

The correct function of OPC Server V3 can be checked without AC500. 

With OPC Server V3 with the configuration SIMULATION3 the Project name 

with the directory name has to be specified. The values of the items can be 

read and wrote by one OPC client. 

6.2 Check OPC Server V3 with AC500 

In this section, you will make the configuration for OPC Server V3 and check the communi-

cation with AC500. 

On the client computer, launch the application ’OPC configurator’. After that, select 

Edit>Append PLC, a new PLC will be added under the Server tree. 

 
Now you need to set the IP address and Port in Connection settings Editor. 

 

Save and close the OPCConfig Editor. 
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Start MatrikonOPC Explorer, Connect CoDesys.OPC.DA, Add Group, Add Items, Select 

Available Items in ‘Server CoDeSys.OPC.DA’,Add to Tag List, Close the Item browser… 

 

Now the variables will be shown and automatically updated. 

If anything is right, then CoDeSys.OPC.DA is connected. The OPC Client is running and the 

quality of the items is good. The values of the items can be read and wrote by one OPC client. 
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7 OPC UA Client for test 
This section describes how to connect between AC500 V3 and OPC UA Client, for example, 

‘Unified Automation UaExpert’, which you download from Unified Automation GmbH 

company. 

The configuration Tools is used to configure the UaExpert’s runtime settings. It is a spe-

cialized UA-Client, capable of the OPC UA DI Profile. The configuration Tool connects to 

the UaExpert using an OPC UA connection. To use the Configuration Tool, the UaExpert 

has to be started and running.  

On the first start, the configuration tool will create a UA application instance certificate. 

Therefore, several information is requested and must be set in the dialog. 

 

After all sections are filled out, the application instance certificate can be generated by 

pressing the ‘OK’ button. 

To add and connect a UA Server to the UaExpert. Click on ‘Add Server…’ to add a connec-

tion to a new UA Server. 
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A dialog ‘Add UA Server’ appears where all need information about the target UA Server 

has to be configured. To find the remote UA Server, you can browse the network and dis-

cover individual computers, or double click on ‘Double click to Add Server…’ and enter the 

remote address of the targeted UA Server. 

This can be done in different ways 

opc.tcp://<hostname>:4840 

opc.tcp://<IP Address>:4840 
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Concerning the Security Settings, choose ‘None’ at Security Policy for the moment. 

 
 

To check if the connection has been established, right click on the server in the ‘Address 

Space’ and click ‘Rebrowse’. The displayed connection status of the server should now 

show ‘succeeded’. 

Drag the desired Items to the Data Access View. 
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The values of the items can be read and write by one OPC UA client. 

For more detailed descriptions please refer to the website   

www.unifiedautomation.com. 

 

 
NOTICE 

Regarding the OPC UA Client test tool, you can also choose the OPC UA Client 

from Kepware (Download Free Demo), … etc. 

 

  

http://www.unifiedautomation.com/
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8 Connection AC500 V2 and OPC UA Client 
This chapter describe an opportunity to connect AC500 PLC with standard OPC Server 

and an OPC UA Wrapper to an OPC UA Client. 

 

Configure your AC500 with Symbol file in the same way you do it for all projects with OPC 

Access. Repeat the same for the OPC Server with the OPC Configurator. 

Please install the Matrikon OPC UA Wrapper (for example) as Administrator and refer to 

the instructions provided by the OPC UA Wrapper accordingly. 

 

9 Behavior of the OPC UA with CP600 
With Panel Builder 600 Version 2.4.0.89 and onwards, the CP600 has the OPC UA 

Server/Client communication driver. The OPC UA Client is designed to connect HMI de-

vices to OPC UA Servers (e.g. AC500 V3 PM5650-ETH in the application example ‘V3 OPC 

Example_V2.5.project’).  

 

 
NOTICE 

OPC UA Server can be from 3rd-party devices or another CP600 as OPC UA 

Server. 

 

In this chapter, adding the OPC UA Server and PLC configuration will be explained as well. 

The diagram below shows the layout of this system. 
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9.1 Protocol Configuration in Automation Builder 

9.1.1 Create new project 

Select the ‘New project…’ from the Menu> Files in Automation Builder. At the New Project 

dialog, select the ‘AC500 project ‘and name your project file. 

 

Click OK to continue and choose the AC500 CPU according to your equipment and click 

‘Add PLC’ to proceed. 



 AC500 HOW TO USE OPC SERVER V3  

 3ADR010407, 2, en_US 33 
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9.1.2 Add OPC UA Server 

Right-click at the “ETH2 (IP Settings)” under the “Ethernet” and select “Add object”. 

 

Select the “OPC UA Server” and click the “Add object” button to continue. 
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You now have the OPC UA Server on ETH2, if you need the OPC UA Server on ETH1, please 

repeat the step and select ETH1. 

 

 

9.1.3 Task Configuration 

Double-click on the “Task” and change the setting as below. 
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9.1.4 Global variables 

Right-click “Application” from the Device tree in the Automation Builder project and se-

lect “Add object”. 

 

Select the “Global Variable List” and change the Object name to ‘GVL_OPCUA’, then click 

“Add object”. 
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Double-click on the “GVL_OPCUA” to open the editor. Create the variables as below. 

 

9.1.5 PLC Logic 

Double-click on the “PLC_PRG” to open the editor and add the coding as below. 

 

9.1.6 Symbol Configuration 

Right-click “Application” from the Device tree in the Automation Builder project and se-

lect “Add object”. 
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Select the “Symbol Configuration” and click “Add object”. 

 

 

A new “Add Symbol Configuration” windows will pop up. 

Check the “Support OPC UA Features” box and click “Add” button to continue. 
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Double-click the “Symbol Configuration” to open the editor. Click on the “Build” button. 

 

 

Select the all the tags under GVL_OPCUA. 
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9.1.7 Online to the PLC 

Right-click on the “PLC_AC500_V3” and select ‘Communication Settings’. 

 

 

The IP address for ETH2 is “192.168.2.10”. Click “Ok” button to continue. 

If your PLC have different IP Address, click the ‘…’ button beside the IP address to launch 

the network scanning tool to search the CPU IP address. 

 

You now ready to go online with the PLC by choosing ‘Login’ from the ‘Online’ menu and in 

the following pop-up window, click “Yes”. 
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A windows pop-up with the notification: “Boot parameters were changed. These changes will 

be applied after reboot.” 

This is due to new “OPC UA Server” protocol have been added to the ETH2. 

 

After downloading completed, go offline and reboot the PLC. 

 

9.2 Panel Builder 600 

In this chapter, we will add the CP6607 panel into the project. 

Right-click “V3_OPC_Example_V2.5” from the Device tree in the Automation Builder pro-

ject and select “Add object”. 
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Select the CP600 Control Panel and change the object name to 

‘OPC_UA_Client_Certificate’ 

 

Double –click on the object ‘OPC_UA_Client_Certificate. 

Uncheck the ‘Connect’ box and uncheck the ’Update Panel Builder project on launch’. 

This is because we don’t not use the ABB CoDeSys V3 ETH protocol. 
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Click the ‘Launch Panel Builder Editor’ 

In the Pop-up Windows, select ‘New’ and click ‘Open’ to continue. 

 

 

At the project wizard, select the CP6607 panel and click ‘Finish’ to continue. 

 

Double-click on the “Protocols” to open the editor. 

Click on the “+” to add the protocol and select “OPC UA Client” in the dropdown list. 
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At the OPC UA Client Windows, type in the “Alias” and “IP address” as below. 

Leave the Port unchanged. 
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Click “Ok” button to continue and save the project. 

Double click on the “Tags” to open the editor, then click on the “Import tags” button. 

 

 

Select the OPC UA Discovery v1.0 and click “Ok” button to continue. 

 

 

Click the “Manual Browse” or ‘Full Browse’ button to pull symbols. 

 
 

Click the ‘Accept temporarily’ button to trust OPC UA server certificate. 
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Wait for it to scan the network. 

 

You can select all tags or only the tags you need. Then click "Ok" to continue. 
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The tags now appear in the dictionaries. 

Select the tags you want and click on the “Import Tags” button or double click the Tags. 
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At the ‘Home’, Draw the graphic as below. 

 

After that link the tags for the value field in the table. 
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Repeat the same for others. 

When complete, download the project to the CP6607 panel. 

 

 

Online with Automation Builder to observe the data values. 
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9.3 Establishing an Encrypted Connection of CP600 

OPCUA Client to an OPC UA Server AC500 V3 

The OPC UA server communicates with connected OPC UA clients over a separate TCP 

connection. Therefore, these connections have to be examined again separately with re-

gard to security. 

This sub-chapter is a step by step example that explains how to configure CP600 device 

to communicate with AC500 V3 using self-signed certificates. 

 

9.3.1 Creating a certificate for the OPC UA Server AC500 V3 

In order to encrypt data and exchange with the client safely, the server needs a certificate 

that the client must classify as ‘Trusted’ when a connection is established for the first 

time. 

Prerequisite, battery is installed in the AC500 V3, and the clock is set to actual time. 
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To create a simple project or directly start the example created above chapter. 

 

Login the PLC and push the ‘Set PLC to PC Time ‘button from option Statistics to set time 

with PC time. 

 

 

Click Menu View and open the security screen (or double click to Security screen button). 
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Select the Devices tab and PLC_AC500_V3 in the left view. 

 
All services of the PLC that require a certificate are displayed in the right view. 

Select the service ‘OPC UA Server(not available)’ and click the Icon  to create a new cer-

tificate for the device. 

 

 
 

The Certificate Settings dialog opens 
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Define the certificate parameters (4096 as Key Length) and click OK to close the dialog. 

The certificate is created on the PLC. 

 

 
 

 
NOTICE 

Keep the online connection to the device before clicking OK button. 

Certificate creation will last about 2-3 minutes. 

 

When complete, reboot the AC500 V3 PLC (Power ‘OFF’ and ’ON’ the system)! 

 

 

9.3.2 Setting up an encrypted connection with the CP600 OPC UA Client 

The following describe using CP600 as OPC UA client and connect to the AC500 V3 OPC 

UA server. Other OPC UA clients should work in a similar way. 

 

Create a simple CP600 Panel project 

Add the OPC UA Client protocol. Enter the IP address of the remote OPC UA server and its 

port number (4840 for V3 PLC). Leave certificate parameters empty.  
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Open tag editor and import tags. Select ‘OPC UA Discovery v1.0’ mode 

 

 

Choose the button ‘Copy to clipboard’ to copy the certificate to the clipboard as shown in 

the figure.  
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NOTICE 

Please be note that the valid time of the certificate must be the same as 

the time set in the OPC UA Server (V3 PLC), otherwise, the communication 

connection will not be established. The reason for the time inconsistency 

may be that you forget to restart the system after setting the OPC UA 

Server certificate, or other reasons. e.g. ‘parameter settings..’ 

 

Then, close this dialog and return to protocol configuration dialog to paste the certificate 

inside the “Server Certificate” field. 
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To verify a certificate, use a text editor to paste it from the clipboard to a text file with the 

extension .crt. You can then double click the .crt file to allow Windows to view the proper-

ties of certificate to be sure about the certificate you are validating. 
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Open tag editor and import tags again, accept the Server OPC UA certificate and import 

some tags.  

 
Note that you can accept the certificate permanently or temporarily. If you accept the cer-

tificate permanently, a copy of the certificate will be saved inside your computer for later 

use without having the popup dialog asking for confirmation. 
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After that, link the tags for the value field in the table. 

 

 
NOTICE 

The certificate file will be copied to the folder: 

%AppData%\Roaming\ABB\studio\OPCUA\pki\trusted\certs 

 

 

 

 

 

Open again the protocol dialog box. Select the Security Policy = Basic256Sha256, and Se-

curity Mode = SignAndEncrypt. 

 

Be sure to uncheck the box of the ‘Hostname validation’ option. 
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NOTICE 

Username and Password creation please refer to the application 

note’AC500 V3 and OPC UA - Configuration and Handling.pdf’, which can 

be downloaded from the PLC website https://new.abb.com/plc/docu-

mentsanddownloads 

 

 

Download the project to the CP600 device. 

 

 
 

In the OPC UA Client protocol parameters, we left the “Client certificate” field empty, the 

OPC UA Client protocol will generated its own certificate and sent it to the OPC UA Server 
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(AC500 V3). Since the server does not recognize the certificate, therefore it rejects the 

connection request.  

Now, we need to tell the server to trust these certificates.  

 

In Automation builder development system, reopen the Security Screen and click the  

symbol button. The view is refreshed. 

 

Select the certificate folder Quarantined Certificates. 

The client certificate HMI-UAClient@HMI-7480 is displayed in the right view, including the 

valid time information, etc. 

 

Drag the certificate to the certificate folder Trusted Certificates. 

 

Now the client certificate is classified by the server as trusted. 

 

Now the communication will start 
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Online with the Automation Builder to observe the data value. 
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9.3.3 Setting up an encrypted connection with the CP600 HMI simulator 

The Simulator works by default with simulated protocols. It can also work with real proto-

cols in case we don’t have the CP600 hardware. 

At CP600 project, launch the simulator and click on the ‘Simulator Settings’ icon. Then re-

move the option ‘Use Simulation’ to use the real protocols for communication with exter-

nal devices. 

 

Now we have to tell the OPC UA server (V3 PLC) to trust these certificates.  

 

In Automation builder development system, reopen the Security Screen and click the  

symbol button. The view is refreshed. 

 

Select the certificate folder Quarantined Certificates. 

The client certificate HMI-UAClient@DE-L-7268277(PC Name) is displayed in the right view, includ-

ing the valid time information, etc. 

 

Drag this certificate to the certificate folder Trusted Certificates 
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Now the communication will start 

 
 

Online with Automation Builder to observe the data value. 
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NOTICE 

When an OPC UA Client attempts a connection with the OPC UA Server, 

the server checks if the client certificate is available inside its own trusted 

certificate list. If it is not found, the communication will be rejected and 

the certificate will be stored in a list of unreliable certificates. 
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10 Connection AC500 V3 High Availability and 

OPC DA Client 
 

 
NOTICE 

For more details how to program High Availability (HA) functionalities using 

Modbus TCP, refer to “AC500 High Availability - HA-Modbus TCP V3 Library 

Example Description 3ADR025289M0208.pdf”  

Start Automation Builder and open the V3 HA Example project 

“V3_HA_ModbusTCP_Example_AB220.project” (location as with all AC500 li-

brary examples folder: C:\Users\Public\Documents\AutomationBuilder\Ex-

amples\PS5601-HA-MTCP\AC500_V3 

 

10.1 Requirements 

The OPC server V3 (version 3.5.10.0 or higher) must be installed from the Automation Builder 

2.2.0. Please refer to the installation description. 

 

By default, the OPC Server (WinCoDeSysOPC.exe) runs in the same user account of the process 

that launched the OPC Server. Depending on the user account this could lead to unpredictable 

behavior. Thus, it’s required to configure the user account for the OPC server.  

 

 
NOTICE 

The OPC server can generally also be registered as service. 

 

10.2 Configure and download symbol file 

Symbol includes the items (variables) which exchanges data with PLC, this is needed for OPC 

communication. The symbol file can be used to check if it is generated correctly. 

To add Symbol Configuration, Right click on ‘Application’ node in the Automation Builder de-

vice tree and select add object and select Symbol configuration (Project-> Add Object->Symbol 

configuration). The symbol configuration editor appears. 
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In Symbol Configuration editor, execute ‘Build’ command to eanble variables selection (you 

need an error-free build). 

 

Then you will see all Items (variables) in the window and select the desired Items which ex-

changes data with PLC, these are needed for OPC communication. 

Only choose the variables which should be communicated and the HA Global variables from HA 

lib as symbol. e.g. In the example, we choose name ‘OPCDA, ‘APP_GVL_Variables’ and 

‘HA_Global_Variables’ for the OPC Items dedicated communication. 
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Go to Online-> Login, with commanding Login the application will be compiled and downloaded. 

10.3 OPC Config 

To start the OPC configuration start the application “OPCConfig.exe” from the installation di-

rectory (Windows ->Start ->3S CODESYS -> CODESYS OPC Server V3 -> OPC Configurator). 

The inserted PLC will be presented in the left window. The configuration will be done at the 

PLC node and the underlying Connection node. 

 

For creating a new communication setup or for modifying an existing one, use button ‘Edit’ to 

open the dialog ‘CoDeSys address of PLC’: 
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Selecting the newly created Redundancy item in the tree list will open a new dialog where it can 

be defined which two of the presented PLC’s shall be combined as one HA PLC pair. 

To start the configuration of a redundant PLC, select the corresponding two PLCs (one after 

the other) and switch them to the right window by pressing '>>'. 

 

After the PLC’s are presented in the right window both individual PLC’s have to be selected and 

the ‘Master Variable’ must be set for both PLC’s to the value< Applica-

tion.AC500_HAModbus.HA_GLOBAL_VARIABLES.xHaModPrimary>.  

This variable is defined in the HA library within CoDesys and it is used by the OPC Server to 

identify which PLC is the Primary. 
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The ‘LifeCounter Variable’ must only be set once to the value< Applica-

tion.AC500_HAModbus.HA_GLOBAL_VARIABLES.dwHaModServerAlive>. 

 

 
NOTICE 

The ‘Master Variable’ must be set for both PLC’s to the value:  

Application.AC500_HAModbus.HA_GLOBAL_VARIABLES.xHaModPrimary. 

The ‘LifeCounter Variable’ must be set the value:  

Application.AC500_HAModbus.HA_GLOBAL_VARIABLES.dwHaModServerAlive. 

If one setting is missing or misspelled (case sensitive) the OPC Server will not 

work properly. 

 

After OPC configuration, please save as “OPCServer.ini” into folder “C:\ProgramData\CoDeSysOPC”. 

 

 

 
NOTICE 

The OPC configuration must be saved as<OPCServer.ini>at the OPC server 

execution directory. 

 

 
NOTICE 

Each change of the OPC configuration will only come to action if the OPC 

server is restarted after saving the configuration as <OPCServer.ini> at the 

OPC server execution directory. 

For more details on the configuration of OPC DA, refer to the online help file 

or AC500 Application description. 
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10.4 Check OPC Server with MatrikonOPCExplorer 

The OPC configuration can be made and tested with any OPC test Client, e.g. MatrikonOPCExplorer. 

 

Connect CoDeSys.OPC.DA, Add Group→Add Tags→Select Available Tags→Add to Tag list… 
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If the OPC Server V3 (CoDeSys.OPC.DA) is connected and running, the quality is good. 

One OPC Client can read/write the values of the items. 
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11 Connection AC500 V3 High Availability and 

OPC UA Client 
 

 
NOTICE 

For more details how to program High Availability (HA) functionalities using 

Modbus TCP (including the CP600 project), refer to “AC500 High Availability 

- HA-Modbus TCP V3 Library Example Description 3ADR025289M0205.pdf”  
 

Start Automation Builder and open the V3 HA Example project 

“V3_HA_ModbusTCP_Example_AB220.project” (location as with all AC500 li-

brary examples folder: C:\Users\Public\Documents\AutomationBuilder\Ex-

amples\PS5601-HA-MTCP\AC500_V3 

 

11.1 Configure and download symbol file 

Symbol includes the items (variables) which exchanges data with PLC, this is needed for OPC 

communication. The symbol file can be used to check if it is generated correctly. 

To add Symbol Configuration, Right click on ‘Application’ node in the Automation Builder de-

vice tree and select add object and select Symbol configuration (Project-> Add Object->Symbol 

configuration). The symbol configuration editor appears. 
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A new “Add Symbol Configuration” windows will pop up. 

Check the “Support OPC UA Features” box and click “Add” button to continue. 

 

In Symbol Configuration editor, execute ‘Build’ command to enable variables selection (you 

need an error-free build). 

 

Then you will see all Items (variables) in the window and select the desired Items which ex-

changes data with PLC, these are needed for OPC communication. 

ONLY choose the variables which should be communicated as symbol. e.g. In the example, we 

choose name ‘OPCUA for the OPC Items dedicated communication. 

 

 

Go to Online-> Login, with commanding Login the application will be compiled and downloaded. 
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11.2 Check OPC Server with ABB Panel CP600 

The CP600 panel configured with OPC UA Client provides the special data type Node Override IP 

which allows you to change the IP address of the target controller at runtime.  

This memory type is an array of 4 unsigned bytes, one per each byte of the IP address. The Node 

Override IP is initialized with the value of the controller IP specified in the project at programming time.  

 

Select the tags you want and click on the “Import Tags” button. 

 

When complete, download the project to the panel. 
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